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AHJ 		Agency Having Jurisdiction

API	Application Program Interface (software that multiple computer systems use to communicate with each other)

Sandbox	An area in which customers can play with and visusalize different PV system panel distributions upon their indivdual homes or businesses.  The sandbox would not requrie any technical data and would not provide plans.

DOE		Department of Energy

FRSPRC		Florida Rooftop Solar Permitting Resource Center

FSEC		Florida Solar Energy Center

kW		kilowatt

PDF		Portable Document Format (Adobe)

PV		Photovoltaic (“generating current or voltage when illuminated”)

GoSolar 1	A Broward County pilot project that allows contractors to obtain solar rooftop PV construction permits online in just a few minutes, within any of 14 partner jurisdictions, using a preapproved set of designs.
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This document describes the Web-related work to be completed under the auspices of the Department of Energy’s (DOE’s) Go SOLAR Florida initiative (DE-FOA-000788).

The broad intent of this portion of the project is to streamline the permitting process for, and to generally promote deployment of, rooftop solar photovoltaic systems for residences and small businesses in Florida.  More information about the core GoSolar objectives and requirements is available in the Statement of Project Objectives (SOPO) for the project.

More specifically, the purpose of the website described in this document is to improve Florida solar permitting in three ways:

1) Automate, standardize and centralize the creation of pre-approved electrical and structural designs.

2) Standardize permitting processes where possible:  Application form, fee tables, inspection requirements.

3) Organize and publish references and resources for use by consumers, contractors, and agencies.
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The main benefit of this project is expected to be derived from centralizing, standardizing, automating, and pre-approving both the electrical and structural designs/plans that are required before rooftop solar PV installation permits can be issued.

1. FSEC will construct a Web-based software component that will accept a set of technical parameters and return a standardized set of pre-approved electrical and structural design documents. 

2. The intent is that FSEC will generate the plans under the appropriate, legislatively-granted authority, so that the plans may be accepted by all partner AHJs with minimal (or no) need for additional review.

3. The FSEC design generation tool will be available for use by anyone with Internet access.

4. The technical parameters required for generation of the designs will be determined by FSEC.  As an example, the GoSolar 1 system filtered the electrical and stuctural design options according to the solar kilowatt capacity of the system and the roof type of the structure.  Then, the contractor would select from a list of applicable designs according to the array and rail configuration. 

For general reference, below are examples of the GoSolar 1 design selection process:
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5. Options for delivery of plans

a. Anyone with Internet access may view, save or print the FSEC design documents, providing they answer the technical parameters required to specify a system (ie. as PDF files).  
b. Contractors could choose to include the pre-approved design documents with the permit application that is submitted to the appropriate AHJ, or:
i. Deliver a printed copy of the FSEC designs together with other AHJ permit application documents.
ii. Possibly, a contractor might submit just a unique reference number for the selected FSEC design document to be “attached” to the permit application they deliver to an AHJ.  For example, a contractor might include a statement on the AHJ permit application like, “This project will use FSEC design #ABC-12345 for the electrical installation and FSEC design #XYZ-98765 for the structural installation.
c. Optionally, the FSEC system selection process might require customers to click a “select this plan” option, to keep track of which plans customers select. 
d. Optionally, the FSEC system could collect and store the name, contact, and general project information from the person who selects the plans.  (But there would be no way of knowing if the plans were actually used to complete an installation.)
e. Optionally, the FSEC system could collect payment of a nominal fee for the plans, to potentially recover some of the costs of creating and maintaining the plans “machine”.

For reference and comparison, the GoSolar 1 system allows anyone with Internet access to see, download, or print PDF versions of any pre-approved electrical or structural design.  Examples are below:
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1) Application Form – Universal?

a. Define a common application format with fields that are acceptable to all partners.
b. Allow applicants to complete the application form directly on the FRSPRC website and submit to AHJ. 
c. Allow applicants to download (PDF) or print a blank copy of the application form or a completed form.
d. Sample information to be gathered:
i. Contractor information (name, address, license, email, etc.)
ii. Acceptance of standardized Terms of Use 
iii. Property information (address, jurisdiction, etc.)
iv. Property owner information (name, address, titleholder and mortgage lender)
v. Project information (title, job value, bonding company)
vi. kW size of system being permitted
vii. Roof type (choose one of six options)
viii. Other technical parameters that may be required by AHJs or the FSEC plan generator
e. Any application data entered into the FRSPRC system would be stored in a centralized database. This would enable future management reports, dots-on-a-map, mailing lists, etc.

NOTE: Additional partner discussion is needed on this topic.  At least one Broward permitting expert thinks it would be counter-productive to accept application data from contractors through a centralized website.  Building departments verify each applicant’s contractor license and insurance when a permit application is signed and submitted.  AHJs already have procedures for this.  So the thought is that accepting data into a centralized online application form would not help that process at all and would actually create duplication and false customer expectations.

2) Fee structures will not be mandated and payments will not be centrally collected and redistributed to agencies, contrary to what was done in the GoSolar 1 project.  If it’s reasonable to do so, fee structure recommendations could be established and published on the website.

3) Like fees, inspection standards will not be mandated.   If it’s reasonable to do so, inspection recommendations and guidelines could be established and published on the website.

For reference, an example of the information collected in the course of a GoSolar 1 permit application is below:
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Set up a single, statewide website to organize and share the resources that will be produced and assembled during this project.

Below are examples of the resource categories that may be incorporated:

1) For Consumers
a. Financial options
b. Solar education
c. Customer sandbox

2) For Florida Agencies Having Jurisdiction (AHJ)
a. Permit application form
b. Zoning ordinance template
c. Permitting standards and guidelines
i. Fee recommendations
ii. Inspection guidelines

3) For Contractors (Permitting Customers )
a. Access to pre-approved electrical and structural system design documents
b. Standardized application form (PDF)
c. Application Package submittal to the permitting systems of the partner Agencies Having Jurisdiction (AHJ)
d. Additional instructions and tips regarding permitting steps; to be provided by AHJ upon application submittal
e. Financial options
f. Solar education
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http://www.broward.org/GoGreen/GoSOLAR/GoSolarFlorida

The above Web page example is from an existing website that was designed and constructed by Broward’s Office of Public Communications (RIGHT??) for this project. 

Because of the requirement for statewide access, the new website probably should be hosted and maintained centrally (i.e. by FSEC), and not by any individual AHJ. 
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http://www.fsec.ucf.edu/en/

The illustration above shows an excerpt from an existing FSEC website.
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1) Although it was discussed many times, project partners generally agreed that a statewide online permitting solution will not be constructed within the scope of this project.  Instead, this project would develop a minimally viable product that captures the concept, look and feel of a statewide online permitting system, but still relies upon the permitting authority of particpating AHJs.  Move toward a statewide online permitting solution would have to be achieved via some other project effort.  Below are some of the reasons behind this decision:

a. Time – It is unlikely that many challenges descripbed below can be resolved within the time frame of the grant. 

b. Duplication – Most agencies already use extensive permitting systems to manage related data, financials, scheduling, performance measures, etc.  It would be challenging (at best) to maintain permitting data in two separate systems.

c. Money – For a statewide system to issue permits on the spot, it would probably have to collect customer payments and redistribute the funds to the appropriate agencies.  Broward County provided that service in the GoSolar 1 project, for a limited number of local municipalities.  But it would be difficult to find an agency to fulfill that critical role on a statewide basis.

d. Contractor Vetting – For the GoSolar 1 project, Broward County verifies the license and insurance of every contractor who requests an online permit.  Again, it would be challenging to establish a statewide authority to authenticate contractors on a statewide basis, so that permits could be issued online.

e. Simplicity for Customers - It might unnecessarily complicate the permitting process if customers are instructed to use one system for a small and specific slice of their business (ie. solar rooftop PV, below X  kW, for residential or small business), but must follow completely different permitting instructions for all of their other work.  Centralized permitting might even slow down and over-complicate the process in areas that already manage solar permits very quickly, efficiently, and inexpensively.

f. Agency-level Permitting - There currently appears to be no example of a construction permit that is issued at the state level.  Permits issued via a centralized system would probably require AHJ branding, which could necessitate inter-agency legal agreements and centralized management of individual agency data (e.g. logos, contact information, etc.).  Broward County executed agreements and manages that type of data for selected local municipalities. It would be very challenging to expand the same solution to include numerous other Florida AHJs.

2) The team discussed the potential benefits of collecting solar permitting information in a central database, to track solar installations in Florida.  To set that up in a meaningful fashion, it would be necessary to establish a standardized method of collecting statewide data (maybe similar to Public Safety’s Uniform Crime Reporting).  

3) Another topic that was discussed at length was the possibility of building interfaces (APIs) to pass data between AHJ systems and the FSEC design generation system.  The exact nature of the benefits to be gained and data to be passed have not yet been established.
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4 kw, Standard 4 Strings and 16 Modules
5 kW, Standard 2 Strings and 20 modules
6 kW, Standard 4 Strings and 24 Modules
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Apply for a New Permit
Terms of Use > Property > Owner > Project > Roof > System > Review > Pay

Pre-approved Systems and Plans

Please indicate which preapproved design options will be used for this project by selecting the correct values
below, If the designs you will be using are not listed here, please contact the appropriate agency directly and
do nof use this system to apply for the permit.

Roof Structure Type: |Barre| Kilowatts:

Structural Design: * 5 kW, 2 x 10 Array - Exposure Category C ~ L& view desian

XYZ Enginesring Company.
1 North University Drive, Suite 40034, Plantation, FL 33324

Electrical Design: * 5 KWV, 2 Strings 20 Modules ~ L& view desian

XYZ Enginesring Company.
1 North University Drive, Suite 40034, Plantation, FL 33324




image6.JPG
()] @ httpsy/gosolsroroward.org/gosolar/Doc £ ~ @ & X
File Edt Goto Favorites Help

| & broward.org o ve &

At least one signature requires validating. [ signature Panel

i P

| ==

may e s e [ F [+ iy sgnedy san spica
e D c-Ls, 2 loncs, -cora

G- v mermatorl,
au-sctuslDepamien.

iy -
e nntapcsatineon  THEEE





image7.png
($5)E)[@ ratps ool browardorg ool Documer £ - @ © X | I GoSolr OnlinePermittr| © browordorg x| | () 57 53
e Goto_roons_rep

LBZeBE

Wari

‘Brovard Rooop Solr Chatenge. 7 rowers ootop S Chaterge Broward Roohop Scar Chaenge





image8.JPG
Apply for a New Permit
Terms of Use > Property > Owner > Project > Roof > System > Review > Pay

Permit Application Summary

Please review the information you entered and make any necessary corrections.

| contractor
|ame; Jeffery . Solar
| company Name: il Solar
| ailing Address: 6519 Ocean Drive, Plantation, AK 33324
+ 554-515-6500
5566884950
£at
3519 N. Grape Bivd), R Louderdale, FL 33016
| Legal Description: GALT OCEAN MILE 34-16 B LOT 12 BLK 7
Folio Number:494315011  Parcel 1d:
Buiding Use: Residential
Property Owner it
Name: seffery Solar
Mailing Address: 3518 N. Ocean Bivd, F. Lauderdale, 33316
Phone Numbe 554-515-6500
Email Address:
Project Information it
Thle: Solar panels
Description: Instal solar panels
Project Value: $30,000.00
Kilowatts (OC Kn): 200
Solar System Information  Edi.
Roof Structure Type: Flat - cther than concrete
Structural Design: Wi i . 2
XVZ Enginaering Company
4 North University Drive, Sute 40034, Plantation, FL 33324
Electical design: [ w1 o and o otes
Marco Perez, P.E., Broward County.
1N University Drive, Plantation, AK 33324
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BREMARD

Go SOLAR Florida Receives Department of Energy
Award to Increase Use of Solar Energy

“The U.5, Department of Energy (DOE) has awarded the Go SOLAR — Florida
team a $1.575 milion, two and a half year Sunshot Inftitive Rooftop Solar
Challenge I1 competitve award to make it easier for Foridians to obtain grd-
ed solar installations. The purpose of the award s to increase the use of and
access to solr energy among the state’s residents and businesses by
reducing market bariers, lowering non-hardare relsted nstalation costs
and providing access to fnancing options, More

FREE Go SOLAR and Renewable Energy Fest on June
6-7,2014

“The Go SOLAR Forida Team wil host the second annual Go SOLAR and
Renewable Energy Fest on June 6-7, 2014 at the Greater Fort
Lauderdale/roward County Convenion Center, i Fort Lauderdale. This
FREE event il feature information on alternative and renewable energy with
 focus on thelatest technologies, finanding options, and creating renewable
energy jobs. The Go SOLAR and Renenable Energy Festis the second amual
outreach event for the Go SOLAR Florida team s 2 partof the Sunshot
Inisative Rooftop Solar Challenge IT grant.

‘The Go SOLAR and Renevable Energy Festis expecting over 2,000
attendees and over 100 renenable energy exhibitors. Regster today to
attend this FREE event, More.

Go SOLAR Florida Draft Charter

“This Charter Document, aiving document that il be revised as necessary to
rack program changes, provides a bref synopsis of the Go Salar — Forida
project, dentifies key players, and summarizes key partner responsbiltes
More.
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FLORIDA SOLAR

RESEARCH |

CONSUMER | EDUCATION
Home >
b AboutUs

b Consumr

Hydrogen Detecti
“Smart Tape”

b Education
“Smart Tape" s a new approach fo:
b Reszarch hydrogen leak detection. Leath about
this product that was developed by
Search FSEC Q researchers at the Florida Solar

Search Papers

Fe)

Job Opes

gs

Upcoming Events

Energy Center.

Energy News In The Know
07/21 Energy 2014
08/13 GraenTrends Confarance | The Eneray Chronicle Blog
& Tradazhow ) Keep up with the latest energy
Energy news, events, and research at
Chronidie

Upcoming FSEC Courses

05/23
05/23
05/23
0s/23
05/23
05/23
05/23

05/23

privacy poliey

Exam; Energ Gauge Class
*performance

Exam: Energ Gauge Class
3

Exam: RESNET Fiskd
Inspector Performanca

Exam: Eneray Star V.3
Retake

Exam: RESNET Fiekd
Inspactor Written

Exam: EnergGauge Class
2

Exam: RESNET Nations!
Cors
Exams Combustion Safety

Terme and Conditions

Explore what alternative energy has to offer.
Reqister today!

ESEC Focus: 'Smart Grid' for Plug-in Vehicles

FSEC,

Solar Testing & Certification
We're one of the leading testing
and certification labs for solar
thermal and PV, take 3 look.

Solar Electric FAQ

UCF's FSEC willlead a $9M research effort for
the creation of DOT's first transportation
center with a focus on electric vehicles.

Mohajeri Wins Research Incentive Award

‘Answers to your questions about
solar electric systems, licensing
and FSEC's installer course,

‘Solar Hot Water Calculator

Dr. Nahid Mohajer received UCF's 2012-2013
Research Incentive Award for her exceptional
energy research efforts.

SunSmart -Shelter School Celebrates
Haines City High School receives 85th
Solar system with battery back-up
from federally-funded program.

Leasl Notices

Find out the savings potential of
residential solar hot water systems.
in Florida.

RESNET HERS Index
Discover how your home's energy
efficiency measures up and what
the score means.
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Apply for a New Permit
Terms of Use > Property > Owner > Project

Project Information

Please provide the information requested below, to describe the project for which you are requesting a
permit. After supplying all required information, click the button to go to the next step. Ttems with an
asterisk (*) are required.

Project Titl 5 Kw solar amay on Johnson residence
Project Description: Solar panels, net metering, 2 x 10 array.
Project Value (USS):* 12345.00

(DC kw): 5.00
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Apply for a New Permit
Terms of Use > Property > Owner > Project > Roof > System > Review > Pay

Roof Structure Type

Please choose one option below to indicate the type of roof structure on which the solar panels will
be installed. If the appropriate roof structure type is not listed, please contact the appropriate
aqency directly and do not use this system to apply for the permit.

© Barrel Tile © Flat - other than concrete Flat concrete

=

* wetal ) Shingle
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